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1. INTRODUCCIÓN   
 
Con el paso del tiempo se han ido realizando cambios en la forma de 

desarrollar y distribuir la información, estos métodos han ido variando desde tiempos 
ancestrales de formas primitivas (ruidos, gestos…), al papel, y en estos momentos a 
métodos digitales. 

 
  El presente proyecto consiste en un CD MULTIMEDIA DE SENSORES USADOS 

EN DOMÓTICA en el cual está desarrollada toda la información necesaria sobre los 
mismos de manera que el usuario pueda acceder a ella de forma interactiva sin que 
éste necesite conocimientos informáticos avanzados.  

 
El proyecto está dedicado en su totalidad a facilitar la consulta, búsqueda, 

asimilación y aprendizaje de cuestiones relacionadas con los sensores electrónicos, de 
esta manera el ordenador sirve al usuario como instrumento para conseguir estos 
fines. 

 Para conseguirlo el proyecto se ha apoyado en numerosas imágenes y gráficas 
que de manera clara y concisa ayudan a que los contenidos se puedan asimilar de 
forma amena, y haciendo que el aprendizaje sea más sencillo y entretenido. Esto se 
consigue mediante el uso de herramientas y aplicaciones multimedia como son 
Macromedia Director, Photoshop… que permiten la interactividad, la edición y 
creación de imágenes y objetos 3D.  

 
 
Con todo lo expuesto lo que realmente se pretende con la realización del CD 

MULTIMEDIA es conseguir una serie de objetivos entre los que se encuentran:  
 

 Diseñar contenidos multimedia (sonidos, imágenes…) que resulten atractivos 
para el espectador. 

 Comprender aspectos básicos sobre el tema del proyecto de manera gráfica.  

 Aprender de forma amena sobre el tema del proyecto.  

 Qué el presente proyecto sirva de método didáctico para completar apuntes.  

 Qué el archivo final tenga un tamaño adecuado para su difusión.     

 Completar la biblioteca sobre sensores de la universidad. 
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2. ANTECEDENTES   

 
El CD MULTIMEDIA es una herramienta innovadora e impactante que 

actualmente se destaca en el mercado multimedia, ya que permite navegar a través de 
un ambiente interactivo que contiene textos, imágenes, gráficos, fotos… De esta 
manera se brinda una imagen moderna al contenido del mismo. 

 Esto se consigue gracias a las numerosas características técnicas y didácticas 
con las que cuenta el CD MULTIMEDIA: 

 

 Gran organización de los contenidos y fácil localización de los mismos a través 
de menús. 

 Alta capacidad de almacenamiento de información, imágenes,… en general 
(archivos) que ocupan un volumen mínimo.  

 Carácter Interactivo (“diálogo entre usuario y ordenador”). 

 Facilidad para su adquisición, renovación o actualización.  

 Muy bajo coste. 

 Facilidad de transporte.  

 Como dice su nombre “MULTIMEDIA” admite formatos de distintos tipos como 
pueden ser texto, imagen, fotos, audio…  

 Impacto ambiental leve. 

 Eliminación de barreras espaciales y temporales (desde su propia casa, en el 
trabajo, en un viaje a través de dispositivos móviles, etc.). 
 
 
Debido a esto los CD´S MULTIMEDIA sirven como complemento didáctico 
óptimo para el aprendizaje, y como elemento de la enseñanza semipresencial o 
a distancia también denominadas (Blended-Lerning y E-Lerning) donde el 
usuario puede manejar los horarios, y trabajar en un medio completamente 
autónomo y que constituye una propuesta de formación que contempla su 
implementación predominantemente mediante Internet, haciendo uso de los 
servicios y herramientas que esta tecnología provee.  
Además los CD´S MULTIMEDIA muestran al usuario la información de manera 

que ésta capte la atención del mismo mediante un contenido llamativo y ameno, de 
modo que el usuario pueda asimilarlo de forma más sencilla.  

 
Por todo lo anteriormente mencionado el CD debe poder manejarse de forma 

autónoma por lo que éste debe poder utilizarse en cualquier lugar y para que esto se 
lleve a cabo hay que plantearse el tipo de documento que queremos realizar y las 
herramientas disponibles para la realización del mismo. Las herramientas disponibles 
en nuestro caso para la realización del CD MULTIMEDIA se centran en el uso de 
aplicaciones que permiten a sus usuarios crear sus propios proyectos multimedia con 
poca o nada de programación y sin necesidad de que esté instalada la aplicación 
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principal, y a las que se les denominan en el ámbito informático como “Authoring” o 
Programas de Autor. Una vez se decide utilizar un programa de autor, hay que decidir 
cuál de todos los existentes es el idóneo para la realización del CD MULTIMEDIA, en 
este caso se ha decidido optar por MACROMEDIA DIRECTOR para la realización del CD.   
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3. POSIBLES SOLUCIONES  
 

Al comenzar un proyecto una vez se tiene la documentación del mismo solo queda 
hacer un estudio previo que consiste en saber cuál será la plataforma para 
desarrollarlo y las imágenes que servirán de apoyo, en este caso se trata de un CD 
MULTIMEDIA por lo que se debe estudiar con qué programas actuales podemos 
realizar el CD y con cuales podemos crear o modificar imágenes. 

 

3.1.  DISEÑO DEL CD MULTIMEDIA 

En el caso del diseño del CD MULTIMEDIA los programas estudiados han sido Flash y 
Macromedia Director. 

3.1.1. ADOBE FLASH 

 
Adobe Flash es una aplicación multimedia usada para aportar animación, 

vídeo e interactividad.  
 

 
Adobe Flash trabaja sobre “fotogramas”, está 

destinado a la producción y entrega de contenido 
interactivo para las diferentes audiencias alrededor 
del mundo sin importar la plataforma. Es 
actualmente desarrollado y distribuido por Adobe 
Systems, y utiliza gráficos vectoriales e imágenes 
ráster, sonido, código de programa, flujo de vídeo y 
audio bidireccional. En sentido estricto, Flash es el 
entorno y Flash Player es el programa de máquina 
virtual utilizado para ejecutar los archivos generados 
con Flash. 

 
 

Los archivos de Flash, que tienen generalmente la extensión de archivo SWF, 
pueden aparecer en una página web para ser vista en un navegador, o pueden ser 
reproducidos independientemente por un reproductor Flash. Los archivos de Flash 
aparecen muy a menudo como animaciones en páginas Web y sitios Web multimedia, 
y más recientemente Aplicaciones de Internet Ricas. Son también ampliamente 
utilizados en anuncios de la web. 

Originalmente Flash no fue un desarrollo propio de Adobe, sino de una 
pequeña empresa de desarrollo de nombre FutureWave Software y su nombre original 
fue FutureSplash Animator. En diciembre de 1996 Macromedia adquiere FutureWave 
Software, y con ello su programa de animación vectorial que pasa a ser conocido como 
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Flash 1.0. Fue hasta 2005 perteneciente a la empresa Macromedia conocido hasta 
entonces como Macromedia Flash y adquirido por Adobe Systems (y desde entonces 
conocido como Adobe Flash) ampliando con ello su portafolio de productos dentro del 
mercado. 
 
 

3.1.2. MACROMEDIA DIRECTOR  

 
Adobe Director es una aplicación de Desarrollo de Software (o Autoría de 

Software) Multimedia (que inspiró a Adobe Flash® ) destinado para la producción de 
programas ejecutables ricos en contenido multimedia. Es considerada una de las 
herramientas más poderosas de integración y programación de medios digitales, 
debido a su versatilidad de poder incorporar imágenes, audio, vídeo digital, películas 
flash, y un engine 3D, en una sola aplicación, y manipularlas a través de un lenguaje de 
programación (Lingo; Javascript).  

 
Desarrollado originalmente por la empresa Macromedia, es actualmente 

distribuído por Adobe Systems Incorporated.  
 

Las presentaciones multimedia generadas 
por Director pueden ser distribuidas a través de 
diversos medios, como discos digitales CD, DVD o 
cualquier otro soporte de información binaria 
pendrives, tarjetas de memoria, discos duros. 
También permite ser distribuido y ejecutado 
directamente en plataformas Web gracias al 
formato Shockwave (creado para esos fines). Con 
Director también es posible programar una 
amplia gama de aplicaciones basadas en redes, lo 
que ha permitido crear innumerables sistemas y 
juegos multiusuario a través de la red.  

 
 
Director también permite la manipulación de modelos en 3D, gracias a 

Shockwave 3D. Es así como diversos programas de modelamiento, como 3D Studio 
MAX (de la empresa Autodesk), permiten exportar sus modelos (incluyendo las 
animaciones) en formato Shockwave 3D, el que puede ser importado a Director, y 
manipulado a través de instrucciones. A través de variados Xtras (como Havok), 
Director también puede manipular propiedades físicas de modelos 3D (como por 
ejemplo, gravedad, coeficientes de roce, restitución, etc) que permiten lograr 
simulaciones más realistas, tanto para software de ingeniería avanzada, como para 
juegos.  
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Además del potente lenguaje incorporado (Lingo), una de sus principales 
ventajas radica en el uso de los llamados xtras. Se trata de “pequeños programas” 
(plugins) desarrollados en lenguaje C++ por otros usuarios o terceras empresas, que 
proporcionan al usuario infinidad de utilidades. 

Se pueden generar varios tipos de archivos, sin embargo lo más normal es crear 
un archivo ejecutable para Windows (.exe) o Macintosh (.app). De esta forma puede 
verse la presentación en cualquier ordenador, sin tener instalado Adobe Director. 

 
 Con el lanzamiento de Director 11 y su evolución a la versión 11.5, de la mano 

de Adobe, se incorporó soporte para DirectX y se extendieron las capacidades en 3D 
basadas en el engine PhysX de NVIDIA, importación de 3D desde Google SketchUp, así 
como también filtros de bitmaps, canales de audio 5.1, vídeo en alta definición, 
soporte para H.264, e integración de Adobe Flash CS3 y Shockwave Player 11. 

 

3.2. DISEÑO DE IMÁGENES  

 
En el caso del diseño de imágenes los programas estudiados son Adobe 

Photoshop y Macromedia Freehand Mx.  
 

3.2.1. ADOBE PHOTOSHOP   

 
Adobe Photoshop (Taller de Fotos) es una aplicación informática en forma de 

taller de pintura y fotografía que trabaja sobre un “lienzo” y que está destinado para la 
edición, retoque fotográfico y pintura a base de imágenes de mapa de bits (o gráficos 

rasterizados).  
 
Es un producto elaborado por la compañía de software Adobe Systems, 

inicialmente para computadores Apple pero posteriormente también para plataformas 
PC con sistema operativo Windows.  

 
Photoshop en sus versiones iniciales 

trabajaba en un espacio bitmap formado por una 
sola capa, donde se podían aplicar toda una serie 
de efectos, textos, marcas y tratamientos. En 
cierto modo tenía mucho parecido con las 
tradicionalesampliadoras. En la actualidad lo hace 
con múltiples capas.  

 
A medida que ha ido evolucionando el 

software ha incluido diversas mejoras 
fundamentales, como la incorporación de un 
espacio de trabajo multicapa, inclusión de 
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elementos vectoriales, gestión avanzada de color (ICM / ICC), tratamiento extensivo de 
tipografías, control y retoque de color, efectos creativos, posibilidad de incorporar 
plugins de terceras compañías, exportación para web entre otros. 

 
Photoshop se ha convertido, casi desde sus comienzos, en el estándar de facto 

en retoque fotográfico, pero también se usa extensivamente en multitud de disciplinas 
del campo del diseño y fotografía, como diseño web, composición de imágenesbitmap, 
estilismo digital, fotocomposición, edición y grafismos de vídeo y básicamente en 
cualquier actividad que requiera el tratamiento de imágenes digitales.  

 
Photoshop ha dejado de ser una herramienta únicamente usada por 

diseñadores / maquetadores, ahora Photoshop es una herramienta muy usada 
también por fotógrafos profesionales de todo el mundo, que lo usan para realizar el 
proceso de “positivado y ampliación” digital, no teniendo que pasar ya por un 
laboratorio más que para la impresión del material. 

 
 Con el auge de la fotografía digital en los últimos años, Photoshop se ha ido 

popularizando cada vez más fuera de los ámbitos profesionales y es quizá, junto a 
Windows y Flash (de Adobe Systems También) uno de los programas que resulta más 
familiar (al menos de nombre) a la gente que comienza a usarlo, sobre todo en su 
versión Photoshop Elements, para el retoque casero fotográfico.  

 
Aunque el propósito principal de Photoshop es la edición fotográfica, este 

también puede ser usado para crear imágenes, efectos, gráficos y más en muy buena 
calidad. 

 
 Entre las alternativas a este programa, existen algunos programas libres como 

GIMP, orientada a la edición fotográfica en general, o propietarios como PhotoPaint de 
Corel, capaz de trabajar con cualquier característica de los archivos de Photoshop, y 
también con sus filtros plugin.  

 
 

3.2.2. MACROMEDIA FREEHAND MX  

 
Macromedia FreeHand (FH) es un programa informático de creación de 

imágenes mediante la técnica de gráficos vectoriales. Gracias a ella, el tamaño de las 
imágenes resultantes es escalable sin pérdida de calidad, lo que tiene aplicaciones en 

casi todos los ámbitos del diseño gráfico: identidad 
corporativa, páginas web (incluyendo animaciones Flash), 
rótulos publicitarios, etc. La historia de este programa en el 
mercado ha sido azarosa. El programa fue creado 
originalmente por la compañía Altsys, y luego licenciado a 
Aldus. Cuando esta compañía y su cartera de productos fueron 
adquiridas por Adobe Systems, los nuevos propietarios se 
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vieron obligados a desprenderse de él: FreeHand se situaba en competencia directa 
con uno de los productos originales más importantes de la empresa (Adobe 
Illustrator), algo que incluso podía constituir un indicio de prácticas monopolistas. 
Después de la intervención de la Comisión Federal de Comercio de los EE.UU., el 
programa volvió a manos de Altsys, que fue comprada posteriormente por 
Macromedia. Esta firma continuó desarrollando el programa desde la versión 5.5 hasta 
la MX. Sin embargo, desde 2003 hasta 2006, Macromedia ha mostrado poco interés en 
el desarrollo del producto, pese a lo cual ha mantenido su cuota de mercado gracias a 
su excelente integración con el resto de los productos de la firma (como Flash o 
Fireworks). De ese modo, FreeHand no ha sido actualizado junto con las demás 
herramientas de la firma ni en el paquete “MX 2004” ni en el “Studio 8”, 
permaneciendo estancado en la versión “MX”. La compra en 2005 de Macromedia por 
parte de Adobe vuelve a colocar al producto en una posición “incómoda” (de nuevo en 
competencia con Illustrator).  

 
Cabe destacar su enorme capacidad para la maquetación de texto, que le 

permite (siempre que no se trate de documentos excesivamente grandes), suplir la 
utilización de aplicaciones específicas como Quark Xpress o Adobe InDesign.  
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4. SOLUCIONES ESCOGIDAS  
 

Tras realizar el estudio previo de las posibles herramientas que se podrían utilizar, 
teniendo en cuenta sus funcionalidades, opciones de diseño, características principales 
y facilidad de uso se decidió realizar el proyecto con las siguientes herramientas. 
 

4.1. MACROMEDIA DIRECTOR  

 
Macromedia Director MX es un programa multimedia de autor muy difundido a 

nivel internacional, además de considerarse la herramienta de usuario final más 
importante para crear medios interactivos para la World Wide Web, CD-ROM, kioskos 
de información, presentaciones e intranet corporativas. La interfaz de fácil manejo de 
Director permite combinar texto, gráficos, sonido, vídeo, gráficos vectoriales y otros 
medios en cualquier orden y, después, añadir características interactivas mediante 
Lingo, el potente lenguaje de programación del programa. 

 
 Por tanto para la realización del CD MULTIMEDIA la herramienta elegida es 

MACROMEDIA DIRECTOR y estas son las principales razones para utilizarlo: 
 
 Compatibilidad con más de 40 formatos de archivo de vídeo, sonido e imagen es 

posible incorporar contenido en casi todos los formatos principales, incluidos los 
archivos SWF, DVDVídeo, H.264, y otros formatos de vídeo, así como en la más amplia 
gama de formatos de sonido y gráficos.  

 
Funciones de audio mejoradas sonido realista gracias a la última tecnología de 

funciones de audio, que incluye el sonido envolvente de 5.1 canales, la mezcla de 
sonidos de 16 canales y filtros avanzados.  

 
Potente compatibilidad con 3D Se puede incorporar el contenido en 3D para 

ofrecer experiencias más atractivas. Crear rápidamente sofisticados entornos en 3D 
utilizando millones de modelos en 3D ya definidos y disponibles a través de Google 
SketchUp y Google 3D Warehouse, y sacar provecho de la compatibilidad con DirectX 9 
para la representación tridimensional nativa.  

 
Compatibilidad con Unicode Localice fácilmente sus aplicaciones para los 

mercados internacionales gracias a la compatibilidad con Unicode.  
 
Motor físico mejorado Crear nuevos niveles de movimiento e interacción 

dinámicos y avanzados en sus juegos y simulaciones con el motor NVIDIA PhysX.  
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Script Browser mejorado Se ahorra tiempo con la comodidad de hacer clic para 
introducir una secuencia de comandos; la facilidad de acceder a información sobre 
funciones, eventos, palabras clave y comandos; y un diccionario completo de Lingo y 
JavaScript.  
 
Filtros de mapas de bits Variedad de sofisticados efectos visuales como desenfoque, 
sombras paralelas, bisel, brillo y muchos más, con los filtros de mapas de bits que se 
pueden aplicar a través de la interfaz de usuario o de secuencias de comandos.  
 
Plug-ins Xtra Se amplía el entorno creativo, así como el motor de reproducción, con un 
ecosistema en constante crecimiento de Xtras de terceros.  
 
Motor de representación de texto mejorado Se consiguen textos uniformes y nítidos 
para las aplicaciones gracias a un motor de texto potente que mejora la representación 
de la fuente.  
 
Fácil salida en versiones múltiples Puede ser publicado en diversas plataformas y 
tecnologías, con una producción que asegure que la aplicación está lista para los 
clientes en prácticamente todos los ordenadores, quioscos, DVD, CD y la Web.  
 
COMPONENTES DE MACROMEDIA DIRECTOR  
 
La ventana Cast (Menu->Window->Cast)  

En esta ventana es donde almacenamos los elementos importados o creados 
en el mismo Director, que formarán parte de la película. Este es el “almacén” de 
nuestro proyecto.  

 

 
Figura 1: vista del Cast 
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Los diferentes elementos que podemos encontrar en esta ventana son: 
 
 • Navegación por el Cast: Nos permite avanzar y retroceder a través de los 

miembros del reparto.  
• Utilidad para mover los miembros del reparto: Esta es una herramienta muy útil 

cuando tenemos un gran número de elementos en el cast y queremos mover alguno a 
otra posición no visible. Para hacerlo, seleccionamos el miembro del cast que 
queremos mover y luego arrastramos el cuadradito hacia el lugar del Cast a donde 
queremos mover este miembro seleccionado. Al soltar sobre la casilla que queramos, 
veremos que el miembro que teníamos seleccionado se coloca en esa casilla.  

• Script e Info del miembro de reparto: Estos son dos botones fundamentales para 
trabajar en el Cast. En el primero (script) podemos asignar un Script al miembro 
seleccionado. De esta forma este miembro, al ser colocado en el escenario se 
comportará tal y como se le haya asignado en el script de Cast, independientemente 
de donde este colocado. Por ejemplo, si a un miembro le asignamos el script: on 
mouseDown beep end este personaje siempre reproducirá un sonido de alerta del 
sistema cada vez que se haga clic sobre él. El segundo botón (info) nos sirve para 
asignar propiedades particulares al miembro del reparto. 

 
 La ventana Tool Palette (Menu->Window->Tool Palette)  

 
Figura 2: ventana Tool Palette 

 
Esta es la paleta de herramientas de Director. Las diferentes herramientas que nos 

encontramos en ella son:  
• La primera herramienta es el puntero. Sirve para seleccionar y mover objetos por 

el Stage (escenario).  
• La segunda es la herramienta de giro. Sirve para girar de forma libre los sprites 

que hemos colocado en el escenario.  
• Luego tenemos las figuras con relleno y sin relleno. Estas figuras tiene la 

particularidad de ocupar muy poca memoria, lo que agilizará nuestra película si se 
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reproduce en internet, por ejemplo, en donde la velocidad de ejecución en un punto 
crítico.  

• Los botones de selección y radio, son los típicos botones que encontramos en 
aplicaciones y páginas web. Más adelante veremos cómo utilizarlos para recoger 
información a través de Lingo. 

• Las herramienta siguiente nos sirve para asignar un color de fondo y frontal a 
nuestras figuras, campos de texto, etc..  

• Las últimas herramientas son las de color y grosor de linea.  
 
Inspector de Texto (Menu->Window->Inspector->Text)  
 

 
Figura 3: inspector de texto 

 
Aquí asignamos tipos de letra, alineación, espacio entre líneas, etc, para los textos 

y campos de texto.  
 
La ventana Behaviour (Menu->Window->Inspector->Behaviour)  
 

Es un pequeño asistente que nos permite asignar Scripts de Lingo, sin 
necesidad de escribir el código, sino seleccionando los handlers y las acciones que 
queramos ejecutar. Más adelante veremos los conceptos de handler y script con 
mucho más detalle. Utilizar la ventana Behavior no es la forma más limpia de 
programar en Director, y siempre que podamos, debemos escribir el código nosotros 
mismos. Esto no es una simple cuestión de estilo, sino que el abuso de los scripts 
generados en la ventana behavior puede llegar a saturar proyectos medianamente 
grandes, provocando comportamientos inesperados. Las indicaciones del gráfico, de 
momento, son lo suficientemente explicativas. Cuando entremos en temas de Lingo, 
aprenderemos a utilizar los scripts de forma extensa y pormenorizada. 
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Figura 4: Ventana behaviour 

 
 La ventana Score (Menu->Window->Score)  
 

Director. Sin embargo, una vez que comprendemos sus funciones, y 
empezamos a hacer nuestros primeros juegos en ella, se va transformando 
simplemente en una herramienta poderosa y versátil. 

Debemos entender el Score, como un secuenciador, o una partitura, en donde 
colocamos todos los elementos de nuestra película. Cuando la cabeza de reproducción 
comienza, va leyendo todo lo que encuentra, a la velocidad que le hayamos asignado, 
interpretando y obedeciendo a los scripts que hayamos puesto en su camino y 
moviendo o mostrando los sprites que hayamos colocado en los canales. En el gráfico 
inferior vemos las partes principales de la ventana score. 
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Figura 5: Ventana Score 

 
 
ACTIVIDADES QUE PODEMOS REALIZAR CON MACROMEDIA DIRECTOR  
 
Incorporar gráficos en la película  
 

En Director podemos importar una serie muy amplia de formatos gráficos, 
como por ejemplo, GIF, JPEG, PNG, BMP, PICT, etc. 
 

 A la hora de importar imágenes en Director es muy importante pensar para 
qué las vamos utilizar, para decidir el formato correcto. Una pantalla de ordenador 
funcionando a 256 colores corresponde a 8 bits de profundidad de color, una pantalla 
a miles de colores corresponde a 16 bits, y una pantalla a millones de colores 
corresponde a 24-32 bits.  

 
Si queremos mostrar fotografías de gran calidad podemos optar por 16, 24 ó 32 

bits, pero si lo que importamos son imágenes para animación será suficiente 
importarlas a 8 bits de profundidad de color, de este modo nuestra película ocupará 
menos memoria y funcionará más rápido.  

 
No tiene en absoluto ningún sentido que realicemos una animación con 

imágenes a 32 bits, porque por un lado nuestra película ocupará demasiado y se 
arrastrará muy lentamente en un CD-ROM de 4X velocidad, e incluso en CD-ROM de 
mayor velocidad.  
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Por eso es conveniente probar las películas directamente en CD antes de 

distribuirlas para evitarnos sorpresas. Importar gráficos (Menú -> File -> Import). 
 
 Supongamos que tenemos los gráficos que vamos a introducir en nuestra 

película preparados en su carpeta o directorio correspondiente. Seleccionamos la 
opción del menú File -> Import, y obtendremos una ventana similar a la mostrada en la 
figura siguiente: 

 

 
Figura 6: captura “import files” 

 
 
 Si queremos importar un solo archivo, seleccionamos en la parte superior el 

archivo y pulsamos “IMPORT”, de este modo pasaremos a la pantalla siguiente en 
función del tipo de archivo que hayamos importado. 

Si queremos importar más de un archivo a la vez, vamos seleccionando los 
archivos y pulsando el botón “ADD”, de este modo los archivos que serán importados 
se van alineando en la parte inferior, y al pulsar “IMPORT”, se importarán todos los 
archivos que hayan sido pasados a la ventana inferior.  

Si queremos eliminar algún archivo de la selección, lo seleccionamos en la parte 
inferior y pulsamos “REMOVE”.  
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Una vez le hemos dado al botón “IMPORT” y le hemos expresado nuestra conformidad 
a Director, nos aparece una ventana similar a la siguiente en donde podemos fijar 
algunos ajustes.  
 
 

 
Figura 7: opciones  de imagen 

 
Incorporar sonidos a la película  
 

Por lo general, en un editor de sonido podemos ajustar la resolución del sonido 
de igual modo que hacemos con los gráficos en un editor de imágenes.  

Los principales parámetros que podemos configurar en un sonido son: 
 

 Frecuencia de muestreo (Khz).  

Número de bits utilizado para codificar cada muestra (resolución).  

Mono o estéreo.  
 
En Macintosh podemos importar básicamente sonidos AIFF o System 7 Sound, y 

en la versión 7 de Director también en Formato Sun .au, que es el formato de sonido 
utilizado por las applets Java.  

 
Para ambas plataformas Macintosh y PC el formato de sonido recomendado es 

AIFF. Así mantendremos la máxima compatibilidad entre las dos plataformas. La 
frecuencia de muestreo recomendada para el sonido (a ajustar en nuestro editor de 
sonido preferido), es de 22,050 Khz ó 11,025 Khz. Los sonidos con frecuencia superior 
a esta, pueden bloquear una película ya que hay que tener en cuenta que por lo 
general cuando ponemos en una película una animación gráfica y un sonido, estamos 
obligando al procesador a realizar dos operaciones, una actualizar el gráfico y otra leer 
y reproducir el archivo de sonido.  

 
Cuando desarrollamos una producción multimedia, tenemos que tener en 

cuenta que este material debe poder reproducirse en sistemas inferiores a aquellos 
con los que estamos desarrollando la aplicación, como PC´s con procesadores más 
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lentos, menor capacidad de memoria, lector de CD/DVD de menor velocidad, etc. 
Importar sonidos (Menú –> File -> Import).  

 
El proceso de importar sonido es exactamente el mismo que a la hora de 

importar un gráfico, pero el sonido tiene menos peculiaridades en este proceso que los 
gráficos.  
 
Incorporar vídeos a la película  

 
A cualquier ordenador le cuesta mucho esfuerzo reproducir video. Con el video 

digital debemos tener aún más cuidado que con el sonido, ya que aparte de que un 
vídeo de unos pocos segundos a 320 X 240 pixels ocupa varios megas en el disco duro, 
la reproducción de este en pantalla es una tarea pesada para cualquier tipo de 
ordenador.  

 
Si el vídeo además tiene sonido, debemos vigilar que el formato del sonido 

también sea el adecuado, si no queremos que nuestro video vaya a saltos y pierda 
fotogramas intentando sincronizar la imagen con el sonido.  

 
Sobra decir que es tarea imposible intentar reproducir a la vez dos videos con 

sonido en pantalla a un tiempo y esperar un resultado lejanamente aceptable. Aunque 
podemos hacer video digital al tamaño que queramos en un programa editor de video, 
como Adobe Premiere, hay algunos formatos estándares que nos convendrá usar, 
como el estándar QuickTime (320 X 240 pixels). Este formato es el más grande 
recomendable a la hora de insertar video en nuestra aplicación multimedia. Importar 
vídeos (Menú –> File -> Import).  

 
Aquí vemos las propiedades del video a las que podemos acceder en la ventana 

Cast:  
 

Playback: Este es el principal control de la reproducción de vídeo en Director. 
Sus diferentes opciones son:  

Video: Indicamos si queremos que se vea el vídeo en el escenario, o bien sea 
invisible, pero conservando las propiedades del sonido.  

Sound: Indicamos si nuestro vídeo tendrá sonido o no. Es conveniente 
desactivar esta opción si el vídeo que hemos importado no tiene sonido, así QuickTime 
no intentará ajustar la imagen a un sonido hipotético, y el vídeo funcionará más 
fluidamente.  

Paused: Con esta opción definimos si el video, por defecto comienza en 
pausa. Siempre podemos arrancarlo luego con Lingo.  

Loop: Con esta propiedad activada el vídeo se reproducirá de forma continua, 
volviendo al principio cada vez que haya terminado, a no ser que eliminemos esta 
caracteristica desde Lingo, o volvamos a la ventana Cast para desactivarla. 
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 Opciones:  



Direct To Stage: Es una propiedad por defecto del video. Normalmente el 
video nunca deja que otro elemento se ponga sobre él, bien sea texto, un gráfico, etc. 
Si un gráfico pasa por delante del video, el video se pondrá sobre él de forma que no 
podremos verlo mientras se encuentre en el ámbito del video. Si desactivamos esta 
opción, el vídeo dejará pasar sobre él a los demás miembros de la película pero, en 
contrapartida, funcionará a saltos y de forma poco fluida, por lo que no conviene 
desactivar esta opción.  
 

Show Controler: Nos mostrará la barra de progreso de la película QuickTime, 
mientras funciona en el escenario.  

Video: En este menu tenemos dos opciones:  

Sync to Soundtrack, habilita que QuickTime ajuste el sonido a la 
imagen, de forma que una no vaya más rápido que la otra.  

Play Every Frame (No Sound), elimina el sonido del video, caso de 
tenerlo, e inhabilita el intento de QuickTIme por sincronizar imagen y sonido, 
con lo que el video irá más fluido en pantalla.  

 
 

4.2. ADOBE PHOTOSHOP CS3 

 
 

 
 
He elegido Adobe photoshop CS3 por sus 

infinitas posibilidades para crear formas, 
retocar imágenes y tratar texto. 
 Además, es un programa que ya había 
usado en otras ocasiones por lo que ya tenía 
el software instalado y sabía cómo usarlo. 
 
 
 
 
 

ACTIVIDADES REALIZADAS CON ADOBE PHOTOSHOP CS3 
 
Creación de flechas 
 Una flecha en photoshop es una línea personalizada. Para crearla deberemos 
seleccionar la herramienta línea del cuadro izquierdo. 
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Figura 8:barra de herramientas y forma personalizada 
 

Y luego desplegar el menú herramienta forma personalizada. Aquí elegiremos 
la anchura, longitud y concavidad de la punta de flecha, asi como si queremos que el 
primer click sobre el lienzo sea el inicio o el final de la flecha. 
 
 
 
 
Creación de animaciones .gif 
 

La primera tarea para realizar un GIF animado con photoshop es crear un 
archivo .psd que es el formato propio de photoshop donde podemos mantener capas, 
que serán necesarias para realizar el GIF animado. 
 

Cada capa creada con photoshop puede ser un fotograma del GIF animado, asi 
que podemos crear tantas como imágenes queramos que haya en la animación. Luego 
en Image Ready (complemento de photoshop) podremos intercalar esas capas en el 
orden que queramos y asignarles un tiempo de visualización a cada. 
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Figura 9: Vista de capas 

 
 

Una vez creada la imagen con las distintas capas con photoshop podemos 
guardarla con extensión .psd para que guarde toda la información de las capas. 
Una vez guardada podemos pasar el archivo a Image Ready, que es el programa 
que utilizaremos para animar las capas en un GIF animado. 

Para pasar el archivo desde photoshop a image ready cómodamente, 
podemos utilizar el botón que hay en la parte de debajo de la barra de 
herramientas. El botón se encuentra en los dos programas y podemos verlo 
remarcado en la barra de la derecha. 

 
Trabajo con image ready 
 
Para definir cada uno de los fotogramas de la animación y sus 

propiedades tenemos una ventana llamada animación. Si no la vemos al abrir 
image ready, podemos mostrarla en el menú de Ventana>Mostrar animación. 
  

La ventana de animación contiene un botón para añadir fotogramas que 
tiene forma de documento nuevo. En cada fotograma podemos seleccionar de 
manera independiente las capas que se desean visualizar, de modo que debemos 
crear los distintos fotogramas de nuestra animación e indicar que capas se deben 
visualizar en cada uno de ellos. Por cierto, las capas se pueden hacer visibles o 
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invisibles desde la ventana de capas con el ojo que hay al lado de cada una de las 
capas. Cuando se puede ver el ojo la capa es visible y cuando no hay ojo es que es 
invisible.  
 

 
Figura 10:tiempo de visualización 

 
Para asignar el tiempo de visualización de cada uno de los fotogramas tenemos 

un registro de los segundos de visualización justo debajo de la miniatura del 
fotograma. Al pulsar sobre este registro de segundos aparecerá una ventana donde 
seleccionar cualquier duración en segundos. 
 
 

 
Figura 11: registro de tiempo 

 
 

Cuando tengamos la animación tal como deseamos que aparezca, seleccionamos 
en el menú Archivo la opción “guardar optimizada como…” y nos aparecerá la ventana 
típica para seleccionar el directorio y el nombre de archivo que queremos asignarle. 
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4.3. ADOBE ACROBAT PRO 

 
A continuación describiré la herramienta informática que junto con Adobe Director 

me ha ayudado a crear este CD multimedia, por tres principales razones: 
 

 Para convertir a PDF este documento desde Word. 

 La principal razón del uso de este programa fue que los textos introducidos en 
el CD no se podían copiar desde Microsoft Word, si no que debían de ser 
convertidos a Adobe PDF, dado que si no ocasionaban errores en Adobe 
Director. 

 Para modificar PDFs con información descargados desde Internet. 
 

A continuación se presenta una descripción breve del programa:  
 

Adobe Acrobat es una familia de programas informáticos desarrollados por Adobe 
Systems diseñados para visualizar, crear y modificar archivos con el formato de Adobe 
Portable Document Format, más conocido como PDF. Algunos programas de la familia, 
especialmente la creación de este tipo de archivos son comerciales, mientras que 
otros, como la lectura de este tipo de documentos, son freeware.  

Adobe Reader (denominado anteriormente Acrobat Reader) está disponible sin 
cargo alguno en la página de descargas de Adobe, y permite la visualización e 
impresión de archivos PDF. Acrobat y Reader son de uso muy popular como forma de 
presentar información con un formato fijo similar al de una publicación. Cuenta con 
versiones para los sistemas operativos Microsoft Windows, Mac OS, Linux, Windows 
Mobile, Palm OS, Symbian OS y otros. El uso del formato PDF está ampliamente 
extendido para mostrar texto con un diseño visual ordenado.   
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5. EQUIPO NECESARIO  

 
Este CD-MULTIMEDIA DE SENSORES está pensado para trabajar con el sistema 

operativo que actualmente es el más utilizado, en este caso es Microsoft Windows, ya 
que se ha creado y desarrollado con Macromedia Director y este programa es 
compatible con este sistema operativo.  
 
Los requerimientos mínimos para la visualización óptima del CD-ROM son: 
 
 - Procesador IntelR Pentium 4 o equivalente a 2GHz (Recomendado 2,4 GHz).  
- 0,5 GB de memoria RAM (Recomendada 1GB según versión del SO).  
- MicrosoftR WindowsR XP con Service Pack 2 , Windows Vista o Windows 7.  
- 300MB de espacio disponible en el disco duro si se va a producir la copia del CD.  
- Disponibilidad de unidad de CD-ROM/DVDROM.  
- Tarjeta grafica y monitor con una resolución mínima de 800x600 pixeles y 256 
colores.  
 
 

Se recomienda para una mejor reproducción del CD MULTIMEDIA copiar el 
contenido del mismo en el disco duro del ordenador, ya que esto facilitara la lectura de 
la información. Esta lectura pasara a ser mas rápida ya que al CD le cuesta más 
reaccionar a las acciones iniciadas y de este modo el CD MULTIMEDIA se ejecutara de 
manera más efectiva.   
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6. ESQUEMA CD INTERACTIVO 
 
 CONFORT 
 Temperatura 
 Resistivo 
 Termistor 
 Termopar 

 
 Luminosidad 
 LDR 
 Fotovoltaico 

 
 Humedad 
 Resistivo 
 Capacitivo 

 
 

 CONSUMO 
 Inductivo 

 
 EMERGENCIA 
 Humo 
 Iónico 
 Óptico 

 
 Fuego 
 Infrarrojo 
 Ultravioleta 

 
 SEGURIDAD 
 Ventana o puerta abierta 
 ReedSwitch 

 Presencia 
 PIR 
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7. DESCRIPCION DE LAS PANTALLAS 

7.1. PANTALLA INICIAL 

 
Pantalla de inicio del CD Multimedia en la que aparece el titulo general. Al cliquear 

sobre “ENTRAR” se accede a la siguiente pantalla. 
 
 

 
Figura 12: Pantalla inicio 

 
 

7.2. PANTALLA DE SELECCIÓN POR FUNCIÓN 

 
Pantalla donde se muestran los tipos de sensores. Al cliquear sobre el titulo o 

imagen de cada uno se accede a los mismos. 
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Figura 13: Pantalla de selección por función  

 
 

7.3. PANTALLA DE NAVEGACIÓN 

 
Desde esta se tiene acceso a todos los contenidos. En la parte superior vemos 

en que categoría estamos y a las que podemos ir (confort, consumo, emergencia y 
seguridad). También está el botón de salida y el de inicio. 

En la parte izquierda vemos el tipo de sensor seleccionado (marcado con una 
flecha azul) y otros que pertenecen a la categoría. 

 
Dentro del marco de contenidos, en la parte superior, está el menú de 

contenidos donde podemos elegir entre descripción, teoría, datasheets o gráfico.  
 

 Descripción: el funcionamiento del sensor. 

 Teoría: los fenómenos físicos por los que funciona el sensor así como 
definiciones de los términos necesarios para comprender la lectura.  

 Datasheets: las hojas de datos de algún fabricante.  

 Grafico: Animación para la fácil comprensión del funcionamiento del 
sensor. 

  
Por último, están los botones adelante/atrás que nos permiten movernos dentro de 
cada subseccion (descripción, teoría, datasheets o gráfico). 
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Figura 14: Pantalla de navegación  
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ANEXO: 
CÓDIGO DE 

PROGRAMACIÓN 
DE DIRECTOR 
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Lingo es el lenguaje de programación que lleva incorporado Macromedia 

Director. Permite integrar con relativa facilidad texto, imágenes, sonidos y video 
digital, siendo una alternativa a lenguajes más tradicionales, como el C/C++, porque el 
desarrollo de la aplicación es mucho más rápido y flexible. El soporte para publicar 
suele ser el CD y desde hace algún tiempo, con la ayuda de Adobe Shockwave, también 
la WWW. Ahora mostraremos algunos de los códigos de programación utilizados para 
la realización del CD MULTIMEDIA. 
 
 
COMANDO PARA DESPLAZARSE A LAS MARCAS DENTRO DE UNA PELÍCULA . 
on mouseUp 
go to frame "Principal" 
end 
COMANDO PARA DESPLAZARSE A LA MARCA SIGUIENTE SIN IMPORTAR SU 
ETIQUETA. 
on mouseUp 
go to marker (1) 
end 
COMANDO PARA DESPLAZARSE A LA MARCA ANTERIOR SIN IMPORTAR SU 
ETIQUETA. 
on mouseUp 
go to marker (-1) 
end 
COMPANDO PARA DESPLAZARSE A LA MARCA QUE SE SITUA EN OTRO ARCHIVO. 
on mouseUp 
go to frame "4.1.a" of movie "Másicos.dir" 
end 
SALIR DEL PROYECTOR. 
on mouseUp 
halt 
end 
C D M U L T I M E D I A S E N S O R E S D E C A U D A L 
Página 155 
COMANDO PARA HACER UNA PAUSA EN LA PELÍCULA MANTENIENDO ACTIVADO 
TODO LO REFERENTE A ELLA, ESTO INCLUYE PRINCIPALMENTE LAS ACCIONES Y 
ESTADOS DE LOS BOTONES Y OTRAS AREAS INTERACTIVAS. 
on mouseUp 
go to the frame 
end 
COMANDO PARA CAMBIAR DE COLOR LOS LOS DIFERENTES VÍNCULOS DE 
NAVEGACIÓN 
on mouseUp 
go to frame "Presión diferencial" 
end 
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on mouseenter 
member(74).color = rgb(28,242,41) 
end 
on mouseleave 
member(74).color = rgb(255,255,255) 
end 
on mouseDown 
member(74).color = rgb(255,255,255) 
end 
COMANDO PARA QUE LA PRESENTACIÓN APAREZCA EN PANTALLA COMPLETA 
on exitFrame me 
go the frame 
deskRect=(the desktopRectList)[1] 
(the stage).rect= deskRect 
(the stage).drawRect= deskRect 
end exitFrame 
COMANDO PARA CREAR UN LINK A LA PÁGINA WEB DESEADA 
on mouseUp 
go to the Net "http://www. ..." 
end 


